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Introduction

FoxMail is a MS-Windows Internet mail client. FoxMail supports full Internet mail functions, runs under 
Windows 3.1X, Windows 95, and Windows NT environments.
FoxMail 2.1 is a 32 bit program, and runs under Windows 95, Windows NT 4.0, or higher.
Author: Zhang XiaoLong
Homepage: http://www.aerofox.com/fox
Features:
* Fast in sending/receiving/decoding messages.
* Remote mailbox management, delete the messages on server before download.
* Local mailbox encryption.
* Address book supports mail list.
* Preview window, to browse message contents easily
* Attach any size file to your message.
* Auto dial your network.
* MIME and UUEncode compatible.
* Retrieve mail from Multiple POP3 accounts.
* Mailbox Assistant, automatically dispatches the incoming messages to different boxes according to 

the custom-defined rules.
* Browse HTML format mail with your own browser.
* Available in Both English version and Chinese version.

See also: FoxMail 2.1 New Features
See also: FoxMail 2.0 New Features

Technical Features:
* Winsock Specification 1.1 compatible
* Supports the following RFC standards:

* RFC 821    (SMTP)
* RFC 822    (Standards for the Format of ARPA-Internet Text Messages)
* RFC 1725 (POP3)
* RFC 1521 (MIME)
* RFC 1522 (MIME part 2)

* Supports UUEncode and UUDecode.



New features in version 2.0

Compared to the 16 bit version 1.6, 2.0 has many improvements:
* Auto dial up your network(ISP)
* Improved network routines, based on the 32bit TCP/IP stack
* Background sending and receiving
* New address book manager
* Address book supports mail list function
* Colorful and clickable URL to invoke your browser
* Gray the quoted message contents
* Can be set as system default mailer, to be activated from Internet Explorer
* Add a 'Sent box', to move the sent messages to this box automatically
* Open the attachments directly in preview window
* Improved user interface:

* The main window can be split vertically or horizontally
* Dockable toolbar
* Show or hide preview window easily
* An 'Already read' icon is added to mark read/unread easily

* Compatible with the mailboxes from 16 bit FoxMail
* BIG5 and GB Chinese text conversion for Chinese users



New features in version 2.1

Compared to the version 2.0 beta 1,    version 2.1 has many improvements, along with the bugs fixed 
in 2.0:
· Include a mail notification program: Notifier
· View HTML format message directly (MS Internet Explorer required)
· Replied flag for the replied messages
· New messages count in the mailbox list
· Auto packing mailbox file when exiting
· Support Multipart/partial format message
· Right Click popup menu, and Select All short key
· Export/Import messages To/From Exchange, Outlook
· Can be set as default mailer in Internet Explorer
· Date and "Time" shown in mail list
· The POP3 and SMTP TCP port can be set now
· View the mail header information in Remote Mailbox Management Window
· Bugs fixed:

· Error when sending a message without context
· Registry error in Windows NT without the administrator privilege
· Decoding the encoded attachment file name



Versions of FoxMail

There are 16 bit and 32 bit versions of FoxMail:
16 bit:

Latest version is 1.6, with English and Chinese version. Freeware:
English version: ftp://ftp.simtel.net/pub/simtelnet/win3/email/fmail16e.zip
Chinese version: ftp://ftp.simtel.net/pub/simtelnet/win3/email/fmail16c.zip

32 bit:
Version 2.1 for Windows 95/NT

For more information about FoxMail, please visit the homepage:
http://www.aerofox.com/fox



System requirements

This version requires Windows 95, Windows NT 4.0, or higher.
Winsock Specification 1.1 compliant networking environment. That is, to run FoxMail, you must have 
TCP/IP protocol installed in your system. As FoxMail uses the 32 bit TCP/IP stack, it will not work if you 
have only 16 bit TCP/IP stack in your system.
To send/receive messages via Internet/Intranet, you should have an account on an Internet mail server 
(SMTP, POP3 server). If you are not sure about this account, please ask your network administrator or 
your Internet Service Provider.



Installation

1, Create a new directory. For example, c:\foxmail';
2, Copy all of the files extracted from the ZIP file to the created directory;
3, Create a shortcut linked to foxmail.exe
4, Create a shortcut linked to notifier.exe
5, Double-click this shortcut to run FoxMail. The first time FoxMail is run, it will automatically create a 

mail directory and other necessary files for you.
Upgrading from previous version:

Just copy all of the extracted files to your previous FoxMail directory, overwriting the old files.
After installation is complete, be sure to set up your server and account information before you 
attempt to send or receive messages.



Set up your server, account, and other options

Open the Options Dialog, input the necessary information about your server, account, and other 
options.
The following are some of the major options you can set:
Personal:

Name: Input your name here. This field will be used to identify your name when sending out a 
message.

Organization: Your organization. Optional.
Internet Mail Address: Your Internet e-mail address, which should be in format like 

yourname@mail.server.host'.
Reply-to Address:  The message sent out will be replied to this address. Optional.

Mail Server:
SMTP Server: The server that will deliver your messages to the destination hosts.
POP3 Server: The server that will store all of your incoming messages.
Account: The POP3 server user account that identifies your mail box in the POP3 Server. When 

retrieving messages from the POP3 server, an account and corresponding password are needed 
to open your mail box in the server.

Password: The POP3 password for your account. The password you enter here will be saved to 
harddisk (encrypted) so that you need not type password again when you start FoxMail.

Advanced: You can set the POP3 and SMTP port number here.    Please set them as the default 
value, unless your administrator ask you to modify them.

Send:
Message Format: You can use either MIME format or UUEncode format when sending a message. 

MIME format is recommended as it is a standard RFC Internet mail format.
Auto Quoted-Printable encoding: If this option is checked, the composed message will be 

encoded to printable ASCII characters by the Quoted-Printable method if there are non-ASCII 
characters in the message body.

Allow 8 bit characters in mail header: if this option is checked, the message header such as 
Subject will not be encoded even if it contains non-ASCII characters.

Character Set: You can specify your character set as either us-ascii or ISO-8859-1. If you are not
composing message in English, ISO-8859-1 is recommended. If you are composing Chinese 
message, you can select GB2312.

Check new mails after sending: If this option is checked, the Send    button will mean Send and 
receive .

Include Original Message when Replying: You can check this box to include the original 
message body in your replying message.

Receive:
Leave a copy in server: When receiving a new message, if you check this option, the original 

messages are    left in the server, and in next retrieving, the already-retrieved messages will not 
be download again. To delete the messages left in the server, just do not check this option, and 
the retrieving procedure will delete all the    messages.

Check for mails every <> minutes: Check this box, and type a non-zero number of minutes 
between schedules for automatic retriveval and delivery of your messages.

Play sound when new messages arrive: You can specify a sound file(.wav) to play when new 
messages are received.

Check mailbox wasted size when exit: You can set a percent value, if the wasted size of mailbox



file exceeds this value, the mailbox will be packed automatically.
Other Connections:

In this section, you can add your additional POP3 accounts. FoxMail will automatically check mail 
from multiple servers/accounts.

Font&View:
You can set up the message font, mail list font, and printing font here.
Use Internet Explorer to view HTML messages: Some messages sent by Outlook, Netscape 

Mail may include the HTML format context. To display them, you can check this option to let 
FoxMail activate IE in FoxMail window.

Signature:
A signature will be appended in your outgoing message.
You can select to use or not use signature when sending messages. Also, you can write your 

signature in the text box, or specify a signature from a text file.
Label:
You can customize 7 labels with your favorite label text and color. You can mark a message with a 
label, with color and the label text, however, the label will not be sent or received.
To change the label of messages, see Manage your messages
Network:
You can let FoxMail perform the dial-up network function automatically when checking/sending mail.



Address book

In your Address book window, you can add, edit, and delete an address.
Only Name and Internet Mail Address  are needed for an address, and these two items will be used to 
identify a destination address when sending a message.
You can also create a mail list, and add members to mail list. When you send a message to the mail 
list, all the members in the mail list will receive the message.
You can also create a new address book. The created address book files are saved in the address 
directory under FoxMail's executable directory.
See also: Compose a new message



Receive messages

Before you can receive messages from mail server, be sure that the mail server information has been 
entered in the Options dialog box. See the Set up your server' section.
The File menu -> Get new messages command will invoke a progress showing the process of retrieving
messages from the mail server. If your password not set in Options dialog box or it is incorrect, a 
password dialog box will pop up asking for the password.
When the retrieving process completed, a dialog box will show the total messages received. Generally, 
The received messages will be stored in the Inbox, however, if you have defined some rules in mail box
assistance, the received messages may be stored in the corresponding mail boxes automatically.



Compose a new message

When composing a new message, you can specify the following envelop information:
To: Identify the recipient(s) address(es) of this message.
Cc: The messages will also be sent to the Cc recipients.
Bcc: Same as Cc, but the recipients(To, Cc, Bcc) will not know the Bcc recipients names from their 

received message.
From: The sender address. This is your email address, and can not be modified when composing a 

message.
Reply To: Specify the reply address. By default, the reply address is your email address, however, 

by specifying Reply To address, you can let the recipients reply to another address.
Subject: The subject of your message.
Attachments: You can attach any file in your message. The file attached can be any format, any 

size.
After a new message has been composed, you have 3 choices:

Send immediately: The message is saved in the Outbox, and sent immediately
Saved in send queue: The message is saved in the outgoing queue, but not sent at this time. You 

can send all of the queued messages with the command Send queued messages from the File 
menu.

Save for next edit: Save, but do not send. You can edit this message again next time.
Note: The To, Cc, and Bcc address format can either be the raw internet address such as 
someone@host.com' or the name selected from the address book. You can double-click on a 
name(address) in the To: or Cc: edit box to look up it's Internet format address.
How to send message to multiple recipients: You can type multiple addresses or names in To or 
Cc or Bcc edit box., separating each name (address) by a comma. If there are too many addresses, 
press the ENTER key to increase the size of edit box, and type the addresses on another line. You can 
also create a Group in the address book window, and add the address item to the group, so you can 
send messages to the group members by select the group name as the recipient.

See also: Reply, Forward, or Send Again a message



Reply, forward, or send again a message

You can do these operations by selecting the command from the menu or just clicking on 
corresponding buttons on the tool bar.
Reply: Reply a message to its sender.
Forward: Forward a message to other recipients.
Send Again: You can re-send a received or sent message again.

See also: Compose a new message



Manage your mail boxes

The following are system-defined mail boxes:
Inbox: By default, the received messages are stored in Inbox
Outbox: The composed messages and sent messages are stored in the Outbox.
Sentbox: The sent messages can be moved to this box automatically.
Trashbox: Stores the deleted messages. You can restore a deleted message from the Trashbox to 

another mail box transfer it to another mail box.
You can add new mail boxes, and transfer the messages to different boxes.

Tip: You may need to compress the mailboxes to decrease the mailbox data file size. As when a 
message is deleted or transferred out from a mail box, the mail box data file still contains the contents 
of that message. The compress operation will TRULY delete the message from the data file.

See also: Mail box assistance



Remote mailbox management

With remote mailbox management, you can determine which messages are to be downloaded, or 
deleted directly without being downloaded.
From the main menu, select command: Tools->Remote Mailbox, to open the remote mailbox window. In
this window, you can retrieve the remote mailbox information first, mark the remote message 
properties, and then execute the marked operations on the server.
A message can be marked as:

Already retrieved
Retrieve, but not delete
Retrieve, and delete
Delete without retrieving



Manage your messages

Viewing Message: Double-click the selected message to open the message window. You can click on 
the Previous and Next button to view messages in a mail box. Press the ESC key to close the current 
message window.
Add the sender address to address book: In the message window, double-click the From field to 
invoke a address dialog, where you can press the Add to address book button to add the current 
address to your address book.
Message Transfer: To transfer message(s) to a mail box, select the messages in the mail list window,
then do one of the following operations:

- From the Message menu, select the Transfer command
- Click the Move to button on the tool bar
- Drag and Drop the messages to a mail box.

Read and Unread: You can mark a message as Read or Unread status.
Message Label: Messages can be marked as different labels with different colors. From the menu 
Message->Change Label command, you can change the message label. The message labels can be set
in the Options dialog.

See also: Manage mail boxes



Mail box assistance

Mail box assistance is useful if you have a large number of received messages, and want to transfer 
the received messages to different mail boxes automatically.
In the Mail box Assistance dialog box, you can define the rules applying to the incoming messages. A 
rule is an action for a specified condition. For example, you can specify that all of the messages whose 
subject contains a string test be put into a user-defined mail box named mytest.



Run FoxMail on one PC with multiple user

Multiple users can use FoxMail on one PC, running a single copy of FoxMail, while each one has    
his/her own mail directory.
Steps:
1, Create a new directory for each user, using Windows Explorer, e.g.: c:\mydir
2, Create a shortcut to FoxMail for each user, apecifying their own mail directory, the command line 

will be similar to the following: c:\foxmail\foxmail.exe c:\mydir
3, Run the created shortcut, and FoxMail will work on the specified mail directory



Sharing the address book

There are two kinds of address book, one is the system default, the other is the user defined.
You can copy the user defined address book file to another PC, place it in the address  directory in 
FoxMail, so that it can will be be used by FoxMail in that PC.
Note, each address book is stored in two files: .ind and .box

See also: Address book



Network Error while sending or receiving mails

Some of the network errors are listed below:
Can not resolve the host address: FoxMail can not resolve the host address. Usually it's because the 
network is not ready, or the DNS server is not ready, or the network is too busy.
Can not connect to server: The server does not respond to FoxMail's connect request. Usually it's 
because the server is not ready or the network is too busy. Please try again later.
Network time out: FoxMail will terminate current network operation if there is not any response from 
server for a specified number of seconds. You can set the time-out interval in the Setup dialog box.
Sending or Receiving Data failed: Check if the network is still working.



Suggestions and Bug Reports

Suggestions and bug reports are always welcome. Also, I want to know how many people have 
downloaded this program from the Internet or copied it from others, so, please send me feedback if 
you have used it. Your address will be added to my mail list, so I can notify you of new versions of 
FoxMail via E-mail.
You can also find more information in http://www.aerofox.com/fox
Please send a message to:
gzdragon@public1.guangzhou.gd.cn



Copyright

FoxMail is written by Zhang XiaoLong
E-mail: gzdragon@public1.guangzhou.gd.cn
http://www.aerofox.com
Copyright 1997-1998 Zhang XiaoLong. All rights reserved.

Please read the contents of the file license.txt in this package, for the license information.



Invoke FoxMail from Internet Explorer

FoxMail can be set as the system default mailer, so that it can be activated from external programs 
such as MS Internet Explorer, MS Office97, and so on. For example, in IE, click on a mailto: URL will 
activate FoxMail to compose and send the message.
Command: Main menu->Tools->Options->Network, set the checkbox: Check default mailer on start up.
When FoxMail starts, it will check to see whether it is the default mailer. If not, it will ask you whether 
to set it to the default mailer.
You can also set foxmail as default mailer in Internet Exporer Option dialog.
Note: Netscape Navigator invoke the mailer in another way, FoxMail cannot be invoked from Netscape 
Navigator at this time.



How to start Dial Up Network automatically

Command: Main menu->Tools->Options->Network,Check the checkbox: Auto dial up network; Select a 
connection name in the combo box. When FoxMail sends or receives messages, it will check to see 
whether the Dial Up Network is started, if not, it will start the Dial Up Network.



What is BIG5 and GB convertion

If you will not compose or read messages with Chinese characters, you will never need this function.
GB is a character coding standard used in China mainland, while BIG5 is used in Taiwan and HongKong.
The GB coded characters will not be shown in a BIG5 coded operating system directly. So, the built-in 
BIG5 and GB conversion function in FoxMail can help one to read or compose message in another 
Chinese coding standard.
Shortcut Keys: 

BIG5 to GB: F7
GB to BIG5: F8




